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BD FACSCantoII 
數據分析與應用操作 
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• 數據分析(Diva) 

• 多色分析範例與數據管處理 

• Cytometric Beads Array(CBA)原理 

Outline 

mailto:Grace.lin@bd.com
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Principle of Flow Cytometry 

Fluidics 

Optics 

Electronics 

Computer 

Overview of Flow Cytometry 
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4 

Optics pathway of FACSCanto II 
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5 

Optics 4-2-2 CantoII 
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6 

Make sure your panel 

design or fluorescent dye 
is match to detector    
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Electronics 

Electronics 
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8 

Voltage Pulse generation 
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(A) 

(W) 

(H) 

Quantification of a Voltage Pulse 
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單顆細胞圈選原理 

(W) 

FL2-W 

FL2-A 

FL2-W 為細胞經過雷射所需飛行時間, 飛行時
間與FL2-A的關係不是線性者(FL2-W訊號異常
高)則為多聯體細胞不可圈選。 
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Figure 2.  
排除多聯體後, 留下單顆細胞的DNA含量直方圖 Figure 1.  

FL2-Width 對 FL2-Area 散點圖顯示單顆細胞圈選, 以排除多聯體細胞
。 

Singlet gating with W and A  

調整FL2-A電壓值讓第一個波峰落在FL2-A 50左右 

 

P2(singlet) 

直方圖設定show P2(singlet) 

F
L
2
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FL2-W 

FL2-A 
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CV affect data quality 

高流速會造成數據的CV變高, 較差的CV會影響數據的品質, 造成不同時期細胞的比例誤差大於真正的差異性, 做細胞
週期實驗時必須用低流速以獲得較佳的CV值 

好的解析度(CV~3%)下 
能分辨的SubG1 (Apoptosis) 
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1
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List-Mode Data 

Resolution of Diva =2
18  

 
26-262143(4 log)  2-262143 (5 log)  
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1
5 

Dot Plot 

Each dot is an event 

Could observe 2 parameter 
simultaneously 

Contour Plot 
Provide a third dimension by 
joining x- and y-coordinates 
with similar event counts  

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

1
6 

Density Plot 
Density plots are similar to dot plots, 

except colors are used to represent 

the accumulation of events  

Histogram Plot 
Graphical representation of single-

parameter data, where the 

horizontal axis represents the 

increasing signal intensity of the 

parameter, and the vertical axis 

represents the number of events 

(count) 
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1
7 

Drill Down 功能:可利用於複雜多色分析 
將欲分析的gate選起來, 右鍵>Drill Down 
自動產生一新的dot plot 已設定為show 該population 
將X軸與Y軸改成欲分析該群的參數即可   
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1
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Global worksheet 
Show active tube 
data 
 
Normal Worksheet 
Can show different 
tube data at the 
same time 

Global worksheet and Normal worksheet 
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1
9 

Cytometer Setting>Compensation and Threshold setting 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

2
0 

4 log and 5 log display 
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2
1 

Display setting of plot 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

2
2 

Overlay 

On Normal worksheet  

Drag one or multiple tube from Browser over an 
existing plot  

Use Inspector to choose which population 

should be shown 
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2
3 

Right-click on overlay plot  

>Show legend 

Use population hierarchy show more 

information 

Overlay 
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2
4 

Biexponential Scaling 

Show dim population by present data in linear scale, 
strong signal remains in log scale 
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2
5 

Scaled to assigned population 
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2
6 

Select target population by 

different gate 

Different Gate Type 



14 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

2
7 

Show or Hide Gate 

When the gate is showing, hide menu will show up 

When the gate is hiding, show Gate menu will show up 
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2
8 

Gate Hierarchy 

Right-click a tube or plot and select Show Population 

Hierarchy to understand the logic relationship between 

different population 
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2
9 

Population 
Hierarchy 
Inspector 

Gate Inspector 

Gate Hierarchy 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

3
0 

Gate Hierarchy-Creating population subsets 

Multicolor analysis 

Drill Down will create a new plot, while show population change the 

population the plot show without create new plot 
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3
1 

Not 

And 

Boolean Logic  布林邏輯 

Ctrl+P1+P1 then right-click 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

3
2 

Rest of 

Or 

Only available  when  there are 

subset population already 

Boolean Logic  布林邏輯 
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Multicolor Research 
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Appropriate Controls 
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Compensation control 
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BD CompBeads/CompBeads Plus 
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Antibody Isotypes 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Isotype control_Concentration dependent 
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Isotype control Preparation dependent 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

• Necessary control if fluorochrome combinations on one 
cell show reduced resolution between negative / positive 
population due to strong data spread 

Fluorescence Minus One (FMO) 
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FMO Example -- Treg 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

FMO Example -- Treg 
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Biological Controls 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

4
4 

Create Statistics View 
Right-click on stats>Edit Statistics View>Statistics 
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4
5 

Create Statistics View 
Right-click on stats>Edit Statistics View>Population 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

4
6 

When Display Range is selected and the 
statistics view has two populations 
displayed, delta values are displayed. The delta 
values show the absolute difference between 
two statistics (for example, between the P1 
mean and P2 mean.) 
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4
7 

Mean. 算術平均數 

Average linear value for events in the defined population 

Geometric mean. 幾何平均數 

Logarithmic average of the events in the defined population 

較不受極端值影響但無法用在含有0或負數的數據 

Median. 中位數 

Linear value with an equal number of values above and below 

it. 

 

Min. 最小數  

Minimum linear value within a defined population  

 

Max. 最大數 

Maximum linear value within a defined population 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

4
8 

Standard deviation (SD) 標準差 

%Coefficient of variation (%CV) 相關係數 

The SD divided by the mean within a 

defined population, expressed as a percentage 
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4
9 

Export Statistics 

Select one or more statistics 

views. 

File > Export > Statistics. 

locate and select the file, and click Save.  

When prompted, click Append.  

Results will be appended to the selected file 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

5
0 

Auto-export Statistics  

Select item (experiment or specimen or tube) 
Right-click>Batch Analysis 
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5
1 

FCS file from other application software 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

BD Senior Product Specialist  

Grace Lin 林秀鴻 

2016/0314 

利用流式細胞偵測細胞激素 
-微珠免疫分析。 
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Multiple assay platforms 
for Protein Quantitation 

• ELISA (Enzyme-Linked ImmunoSorbent 
Assay ) 

 
• ELISPOT (Enzyme-Linked ImmunoSpoT 

assay)  
 

• Bead-Based Immunoassay 

–Cytometric Bead Array 

– Multiplex 
– …etc. 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

ELISA 
Sandwich Direct 
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Bead Provide a Flexible Platform 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

How A Bead-based Immunoassay Works 

DTT, Dithiothreitol  
Sulfo-SMCC, Sulfosuccinimidyl 4-N-maleimidomethyl cyclohexane 1-carboxylate  
NEM, N-Ethylmaleimide  
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How A Bead-based Immunoassay Works 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Features 

• Evaluation of multiple analytes in a 
single sample. 

• Utilization of minimal sample volumes 
to glean data. 

• Reproducibility and results comparative 
with previous experiments. 

• Direct comparison with existing assays. 

• More rapid evaluation of multiple 
samples in a single platform. 

Ref. 

Am J Clin Pathol 2002;118:346-353 

Curr Protoc Cytom. 2006 Feb;Chapter 13:Unit13.1 
Clinical Immunology Volume 110, Issue 3, March 2004, Pages 252–266 
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Analytes 

• Inflammatory mediators 

• Chemokines 

• Immunoglobulin isotypes 

• Intracellular signaling molecules 

• Apoptotic mediators 

• Adhesion molecules 

• Antibodies 

• …..etc. 
Ref. 

Am J Clin Pathol 2002;118:346-353 

Curr Protoc Cytom. 2006 Feb;Chapter 13:Unit13.1 
Clinical Immunology Volume 110, Issue 3, March 2004, Pages 252–266 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

一根釣竿就可以釣起所有想要的魚 
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BD™ Cytometric Bead Array (CBA)  

• Flow cytometry application  

• Bead-Based Immunoassays 

• Multiplexed quantitation and detection 

• Up to 30 proteins can be analyzed 
using just 25 to 50 μL of sample.  

BD™ CBA Flex Set を用いたタンパクレベル解析 
ヒト末梢血単核細胞（PBMC）を異なる2 つの条件下で刺激
し、上清を回収後 BD™ CBA Flex Set assay（ 30 plex）で測
定した。 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Assay 
Principle 
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Assay Procedure 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

•Analyzed multiple analytes simultaneously. •Reduced sample volume requirement. •Reduced hands-on time by parallel analysis of samples. •Wide dynamic range of fluorescence detection. 
  (requires fewer sample dilutions) •Offer automated sample acquisition and increased throughput. 

BD CBA : 
 designed for easy and efficient 
multiplexing 



33 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Product 
Format 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

CBA Kit 
將常常同時偵測的種類，合併成套裝組合 
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© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Instrument to instrument results 24 hr PMA/Ionomycin 
actiovation sample 
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產品資訊 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Product 
Format 
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CBA FLEX SET 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

CBA FLEX SET 
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CBA FLEX SET Product Line 

• Soluble Protein Flex Set 
– Human Soluble Protein Flex Set 
– Mouse Soluble Protein Flex Set 
– Rat Soluble Protein Flex Set 

• Human TGF-β1 Single Plex Flex Set 
• Human Immunoglobulin Flex Set (For Ab 

Isotyping) 

• Enhanced Sensitivity Flex Set ( 0.274–200 
pg/mL ) 

– Human Enhanced Sensitivity Flex Set 
– Mouse Enhanced Sensitivity Flex Set 

• Cell Signaling Flex Set 
• Functional Beads 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  
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Enhanced Sensitivity 
Flex Set System 

• Quantitation range of 0.274–200 pg/mL 

• Designed for multiplex analysis, providing more data using 
a single sample 

• Open and configurable to maximize flexibility 

• Analyzes soluble proteins with just 25 to 50 μL of sample 

• Works with flow cytometers equipped with 488-nm and 
633-nm lasers 

Features 
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Cell Signaling Flex Set System 

• 定性及定量 
– 可同時偵測Cell lysate 中多種磷酸化蛋白 
– 標準品 

• 單一、少量的樣本可進行多種分析 
• 樣本製備與Western Blot 類似 
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Cell Signaling Flex Set System 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Cellular Communication and Signaling 
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Cell Activation 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Cell Signaling Multiplex Panels 
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Signaling Pathway 
Measured 

PMA/Ionomycin 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Protein Phosphorylation - PMA / Ionomycin 
activation kinetics 
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Protein Phosphorylation - CD3 / CD28 
activation kinetics 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Difference in cellular response to 
PMA/Ionomycin and CD3/CD28 

activation 
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Human soluble protein 30 
plex 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Standard Curve 
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Human Protein level of PBMC 
actived 24 hours with 

PMA/Ionomycin  

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Human Protein level of PBMC 
actived 24 hours with CD3/CD28  
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Difference in cellular response to 
PMA/Ionomycin and CD3/CD28 activation 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

BDTM CBA Functional Bead 

DTT, Dithiothreitol  
Sulfo-SMCC, Sulfosuccinimidyl 4-N-maleimidomethyl cyclohexane 1-carboxylate  
NEM, N-Ethylmaleimide  
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BDTM CBA Functional Bead 

Sulfo-SMCC 

Mix, 

Incubate  

• Step 1: Bead Preparation 
• Step 2: Protein Modification 
• Step 3: Buffer Exchange to  Remove Unreacted 

Components 
• Step 4: Protein Conjugation 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Advantages 

• Simple conjugation procedure completed in 
less than 4 hours. 

• Requires less than 100 μg of protein at a 
concentration of 1 mg/mL. 

• Ability to conjugate any protein molecule 
containing a free amino group to the beads. 

• Compatible with a wide selection of flow 
cytometers for ease of analysis. 

• Specific reagents available for confirming 
the success of conjugation reactions. 

• Supporting reagents and procedures 
available for performing instrument setups 
and assays 
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FAQ 
• What are the physical properties of the BD CBA 

beads?  

– The BD CBA beads are hard-dyed polystyrene-based 
microspheres with an average diameter of 7.5 μm  

• Which blood anticoagulants can be used for 
preparation of serum and plasma samples?  

– EDTA-treated plasma  

• Will hemolysis hinder results in BD CBA assays?  

– A small amount of hemolysis is unlikely to be a problem 
because the samples are washed before acquisition  

• Can BD CBA cytokine or chemokine assays be 
used with tissue lysates?  
– Milano F, Jorritsma T, Rygiel AM, et al. Expression pattern of immune suppressive 

cytokines and growth factors in oesophageal adenocarcinoma reveal a tumor immune 
escape-promoting microenvironment. Scand J Immunol. 2008;68:616-623.  

– Bhowmick S, Duseja R, Das S, Appaiahgiri MB, Vrati S, Basu A. Induction of IP-10 
(CXCL10) in astrocytes following Japanese encephalitis. Neurosci Lett. 2007;414:45-50.  

– Ghoshal A, Das S, Ghosh S, et al. Proinflammatory mediators released by activated 
microglia induces neuronal death in Japanese encephalitis. Glia. 2007;55:483-496.  

– Tong J, Bandukwala HS, Clay BS, et al. Fas-positive T cells regulate the resolution of 
airway inflammation in a murine model of asthma. J Exp Med. 2006;203:1173-1184.  

– Mansour MK, Yauch LE, Rottman JB, Levitz SM. Protective efficacy of antigenic fractions 
in mouse models of cryptococcosis. Infect Immun. 2004;72:1746-1754.  

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

ELISA v.s. CBA 

• E. Morgan et al. / Clinical Immunology 110 (2004) 252–
266 

• BLOOD, 15 AUGUST 2005  VOLUME 106, NUMBER 4 
• Electrophoresis 2009, 30, 4008–4019 
• Methods, Volume 38, Issue 4, April 2006, Pages 317–323 
• Cytometry Part B (Clinical Cytometry) 61B:35–39 (2004) 
• Cytokine, Volume 54, Issue 2, May 2011, Pages 136–143 
 
                  .............. etc 

Comparison 

Correlation 

http://www.sciencedirect.com/science/journal/10462023/38/4
http://www.sciencedirect.com/science/journal/10434666/54/2
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E. Morgan et al. / Clinical Immunology 110 (2004) 252–266 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  
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Thanks! 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

Berthoud et al. Malaria Journal 2011, 10:115 
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1
0
1 

Canto II Loader 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

1
0
2 

Use Canto II Loader for autocompensation 
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1
0
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Carousel>Carousel setting 

© 2016 BD. BD, the BD Logo and all other trademarks are property of Becton, Dickinson and Company.  

1
0
4 

Verify cytometer  setting  

By acquire data, make sure 

all the parameter voltage 

setting is correct 
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1
0
5 
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1
0
6 

Run Carousel 
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1
0
7 
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1
0
8 
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1
0
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1
1
0 
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1
1
1 

Perform quality control of the analysis  


